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C H A P T E R  1  

Installing VRManager Pro
VRManager Pro performs recorded file management — indexing, 
converting, tracking, playback, reporting, and other critical functions for call 
center customers who would like to keep recorded files for administrative, 
legal, or quality assurance purposes. 
VRManager Pro offers security features that were not available in previous 
releases of VRManager:

• You can store voice recordings in encrypted format

• You can now grant specific file record privileges to individual users 
(play, trim, and export)

• You can save VRM application data in an external database

• You can now set password requirements ensure that users create more 
complex passwords

• You can implement password policies; configure appropriate password 
expiration periods, set session timeout durations, and define the 
maximum number of login attempts allowed

• Users can now trim voice recordings and export the trimmed 
recordings. Note that the original recording will not be affected by any 
trimming. Trimmed recordings cannot be saved back to the recording 
media.

• The audio player display has been enhanced

• VRManager Pro is integrated with the CDR database
Limitations:

• VRM Pro cannot read unencrypted recording files that were created in 
earlier releases directly. Instead, VRM Pro will use Windows Media 
Player to play recordings that were captured in earlier releases

For Customers Who Previously Used VR Manager
If you had a previous release of VRManager, you must upgrade to VRM Pro. 
VRManager is no longer supported, beginning with Release 8.5.1.
Follow the steps in the separate VRM Pro Upgrade Guide to upgrade from 
VRManager. Note that no new licenses are required when upgrading.
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VRM Pro Server Requirements
You must install VRManager Pro on a different system than the one on 
which the MaxCS ACM server is installed.
The VRM Pro Server must meet the following requirements. Installation 
requires 1GB of available hard drive disk space; however, more space is 
required for CDR storage and recording files. 

• G.729 is approximately 60KB per minute recording

• G.711 is approximately 480KB per minute recording
Operating systems supported:

• Windows Server 2019

• Windows Server 2016

• Windows Server 2012 R2 (64-bit)

• Windows Server 2008 R2 SP1 (64-bit)

• Windows Server 2008 SP2 (32-bit)
Server System minimum requirements:

• A standalone system

• Intel 2 GHz Pentium IV or faster

• 40 GB available hard drive disk space (note that large recording 
storage will require mode space)

• 4 GB RAM

• MaxCS Release 8.6.1 or later

• A VRManager Server license must be installed at the MaxCS system. 
(You can verify the licenses when you run MaxCS Administrator by 
selecting License > License Information.) 

• Recording Seat/Session licenses are needed for users to work with 
VRM Pro

• IDE RAID 0-1 (minimum) hard drive

• NIC

• Microsoft SQL Server Express 2008 SP1* or SQL Server 2019
* If you are upgrading from VRM to VRM Pro, note that you cannot use 
the SQL 2008 express DB bundled with your old VRManager. It is 
highly advised that you install a new SQL and create a DB in that SQL 
install because in most cases you will not have enough room in the old 
VRManager SQL 2008 Express DB to migrate your records.
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VRM Pro Client Requirements
VRM Pro client systems must meet the following requirements.
Operating Systems supported:

• Windows Server 2019

• Windows Server 2016

• Windows 10

• Windows 8.1 (64-bit)

• Windows 7 (32-bit or 64-bit)
Client system minimum requirements:

• IBM/PC AT compatible system

• 2 GHz CPU or faster

• If installed on the same server with MaxCS, you will need an additional 
2 GB disk space and an additional 2 GB RAM

Pre-Setup Steps
You can use the CDR database as VRM Pro’s database. If you do not want 
to use the CDR database, you should install SQL Server manually before 
you install VRManager Pro. VRM Pro supports an external SQL server only. 
If you choose to install VRM Pro data in a separate database from the CDR 
database, set up that new database before you begin the installation 
process.
Java JRE will be automatically installed for you.
Before running the setup program, please ensure the following.

• File and print sharing must be active on your operating system. To 
verify this (your steps may vary depending on your operating system 
version):
1. In the Control Panel, double-click Network Connections. 
2. On the Advanced menu, click Advanced Settings. 
3. On the Adaptors and Bindings page, ensure that File and Print 

Sharing for Microsoft Networks is selected. 

• Make sure that Silently succeed is selected in the local security 
options named below. 
1. In the Windows Control Panel, double-click Administrative Tools. 
2. Double-click Local Security Policy. 
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3. Expand Local Policies. 
4. Select Security Options. 

• Make sure that the CDR database has already been deployed.

Installing VRM Pro 
During installation, Jservice Loader will be installed on your system 
automatically. 
1. Run the Setup program and follow the instructions on the screen.

2. In the Custom Setup screen, choose to install both VRM Service and 
VRM Admin. If you plan to use the VRM Client at this system, also 
select Voice Record Manager Client. Then click Next.
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3. The next panel asks where you plan to store the VRM Pro application 
data.
VRM Pro and Altigen’s Quality Management application use the same 
database. It is easiest to store all of the application data in the CDR 
database. If you prefer, you can store the VRM Pro and Quality Man-
agement application data in a database that is separate from the CDR 
database. 
Choose whether to store the VRM Pro application data in the CDR 
database, or store it in a separate database. Then click Next.

4. If you chose to store VRM Pro application data in a separate database, 
a panel opens for you to specify the details for that database. Note that 
the SQL DB account must have read/write/update schema privileges 
for that database. 
Enter the information and click Next.
Cloud customers can retrieve this database information from the Alti-
gen Cloud Portal, on the General tab, in the Call Center section.

For this field in the VRM 
Pro Installation 
Wizard...

...enter this information from the 
General tab of the Altigen Cloud 
Portal.

SQL Server Address SQL Server Name

SQL Instance Leave this field blank

SQL DB Name CDR Database Name
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5. In the next panel, specify details for your CDR database and click Next. 
Note that the SQL DB account must have read/write/update schema 
privileges for that database.

SQL DB Account SQL Username

SQL DB Password SQL Password

For this field in the VRM 
Pro Installation 
Wizard...

...enter this information from the 
General tab of the Altigen Cloud 
Portal.
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After you complete the installation process, you can run VRM Pro Admin 
from the Windows Start menu. 
Note: If VRManager Pro is run behind a firewall, open TCP port 10040. 

(VRManager Pro may not work behind NAT.)

Installing VRM Pro Client
To install VRM Pro for a client system,
1. Run the Setup program and follow the instructions on the screen.
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2. In the Custom Setup screen, choose to install Voice Record Manager  
Client.
Note that if you install VRM Pro Admin on a client system, some 
Browse buttons will not appear.

After installation, you can run the VRManager Pro Admin or VRManager Pro 
Client from the Start menu. Use the “Login as Administrator” option to run 
VRManager Pro Admin.
Note: If VRManager Pro is run behind a firewall, open TCP port 10040. 

(VRManager Pro may not work behind NAT.)

Setting Access Privileges
The JService Loader Windows service account must have read/write/delete 
privileges to any folder used by VRM Pro. This includes the following 
folders:

• The Primary storage folder specified on the Pooling tab

• The Backup storage folder specified on the Storage tab

• The Log folder and the Daily report folder, as specified on the Log tab

• The Centralized Recording folder specified on the MaxCS ACM tab 
(read/write/delete privileges are not required for this folder if the 
username and password fields are used)
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Configuring Database Connection
In earlier releases of VRManager, a SQL Server Express instance was 
automatically installed for you. For VRManager Pro, however, we 
recommend that you use your own SQL Server instance, SQL Server 
version 2008 or later. 
After you install VRManager Pro, we recommend that you open VRManager 
Pro Admin and configure your database settings. These steps are 
discussed in the next chapter, “Database Page” on page 26.
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C H A P T E R  2

Using VRManager Pro Admin
To run VRManager Pro Admin:
1. From the Windows Start menu, choose VRManager Pro Admin.
2. Right-click VRM Pro Admin and choose Run as Administrator.

3. Enter the VRM Server IP address or server name and Password. (The 
default password is 22222.)

4. Check the Save Password checkbox if you want VRM Pro Admin to 
remember the password the next time the program runs. 

5. Click OK.
Note: Each Windows user has his own VRM Admin login setting.

VRM Pro Admin Window
VRM Pro Admin has several configuration pages:

• User Page — see page 12

• Pooling — see page 19

• Storage — see page 21

• Log — see page 21

• MAXCS ACM — see page 24

• Database — see page 26

• Integration — see page 26
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User Page
The User page shows the User List for VRManager clients and shows the 
workgroups, extensions, and systems that the user can query. From this 
page, an administrator can add, edit, and delete users; limit their queries to 
certain workgroups, extensions, and systems; change user passwords; and 
change the VRM Pro Admin password.

User Password Requirements
In VRM Pro, user passwords must meet a more complex standard than in 
VRManager. 
When a user changes a password, or when an administrator resets a 
password, it must meet these requirements:

• Passwords must be at least 7 characters long

• Passwords must contain:
 at least one upper-case letter
 at least one lower-case letter
 at least one numeral
 at least one special character: # ! ? ^, or @
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• Passwords cannot contain the user ID

• Passwords must be different from previous passwords

Adding Users
To add a new VRManager Pro Client user: 
1. Click New.

2. Enter a user email address; this must be in email format (for 
example, newuser@altigen.com). The user name is not case-sensitive. 
Enter a password (refer to “User Password Requirements” on page 
12), and confirm the password. 

3. Click OK. The new user appears in the User List field.
4. To limit this new user’s queries and recording privileges, refer to the 

next sections.

Editing User Details
To edit a user:
1. Select the user on the User page and click Edit.
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2. Enter (or update) the name, title, department, workgroup numbers, the 
extension numbers, and system IDs. 
Separate entries with a comma. 
To allow the user to query all workgroups or all extensions, leave those 
text boxes empty. 
To assign recording privileges, refer to the section “Configuring User 
Recording-file Privileges” on page 14.

3. Make your changes, and click OK.
To delete a user, select the user and click Delete.

Configuring User Recording-file Privileges
Administrators can now grant various privileges to individual users as 
needed. Actions on recording files are logged, so that Administrators can 
identify any actions upon a recording file.
1. Select the user on the User page and click Edit.
2. Check the appropriate Privilege checkboxes to grant permissions for 

this user, and then click OK.

• Play – Allows this user to play voice recordings
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• Trim – Allows this user to trim a voice recording and export it. The 
original recording will not be affected by trimming.
Trimmed voice recordings cannot be saved back to the recording data.

• Export – Allows this user to export recordings

Configuring User Quality Management Privileges
AltiGen now offers a new Quality Management application, which can be 
used for assessing the quality of voice recordings. Assessments are accom-
plished by a user listening to a recorded call while scoring the agent's per-
formance on that call. Performance is scored by responding to a series of 
evaluation questions within an assessment form. 
For information on ordering and using the Quality Management application, 
contact your AltiGen representative.
Administrators can grant Quality Management privileges for each user, 
designating the user as an Admin or a User (or both). 
1. Select the user on the User page and click Edit.
2. Select the role(s) for this user:

• Admin – Admins can set system configuration options and edit user 
privileges within the Quality Management application.

• User – Users can log into the Quality Management application. More 
specific privileges, such as the ability to perform assessments and work 
with forms, can be set by Admins within the Quality Management 
application itself. 

Reviewing Activities Performed on Recorded Files
Administrators can now view details for recordings that have been viewed, 
trimmed, or exported within a certain time period.
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1. On the User tab, click Activity.

A new Activity panel opens. The panel may initially be empty. 
2. In the lower right corner, click Search. 

In the Search panel, specify the search criteria. 

3. In the upper set of fields, specify which activities to search for:
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• User — Select a user, or leave the field set to All to show all records 
for all user activity.

• Operation — The type of activity you're looking for.
 All — Shows records for all user operations
 Play — Shows only those records where the recording was played 
 Trim — Shows only those records where the recording was trimmed
 Export — Shows only those records where the recording was 

exported

• From/To — Date range of the activity. Choose a begin and end date 
and time, to find recordings that were played, trimmed, or exported 
during a specific time frame.

4. In the lower set of fields, you can narrow your search for a specific voice 
recording that has been played, trimmed, and/or exported. These fields 
are optional.

• Date of Recording — A date range of the recording. Enter the From 
and To fields to narrow the results to those messages that were 
recorded during a specific time period.

• Callee ID — Specify a specific callee ID for the recording.

• Caller ID — Specify a specific caller ID for the recording.

• DNIS — Specify a DNIS for the recording.

• Workgroup — Specify a workgroup for the recording.

• Length — Specify a length for the recording.

• Session ID — Specify a Session ID for the recording.

• Comment — Search for a keyword in a comment for the recording.

• Call Disposition — Specify a Call Disposition Code.
5. After specifying the search criteria, click OK. The results appear in the 

panel. 
The next figure shows an example of a search for records that were trimmed 
on a specific date. You see the activity “Trim” in the Operation field, and a 
single date of May 17th in the Operation Date field.
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On the results page, you can sort the results by any of the columns. For 
example, click the column heading User to sort by user name. Click the 
heading again to reverse the sort order.
To export the data to a CSV (Comma-Separated Value) file, click Export. In 
the Save dialog box, specify the location and a filename. Click Save.

Changing the Admin Password
To change the VRM Pro Admin password:
1. On the User tab, click the Change Admin Password button.

2. Enter the information in the Old Password, New Password and Confirm 
Password fields, and then click OK.

Configuring Password Policy
Note that user passwords must now meet specific requirements; see “User 
Password Requirements” on page 12.
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You can set global policies for user password expiration and login attempts.
1. On the Users tab, click Configure Password Policy.
2. In the next panel, customize the options as appropriate for your 

organization and click OK:

• Passwords expire in: Enter how long, in days, a password can remain 
active. Your entry must be a number from 7-365. Once that interval has 
passed, users will be required to create a new password. 
If a user logs into the VRM Pro client while the password is within 7 
days of expiring, the user will be prompted to change the password.
Once a user’s password has expired, the user will be permitted to log 
in, but will be forced to change his or her password before using the 
VRM Pro client. 

• Inactive sessions log out in: Enter how long, in minutes, a session 
can remain active. Your entry must be a number from 5-60. Once a user 
has been inactive for the full interval, the system will prompt the user to 
log in again.

• Maximum login retries until account is locked: Enter how many 
times a user can incorrectly log in before the account is frozen. To be 
considered a retry, the entered password must be different from the last 
attempt. Your entry must be a number from 1-10. Once an account is 
locked, it remains locked until an admin unlocks it by resetting the 
password.

Pooling Page
The pooling page lets you set the location of the primary storage directory 
and specify file format.
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Storage Directory
Click Browse to select the location. VRM Admin pools the newly recorded 
files from the MAXCS server, and saves them into the primary storage 
directory in .wav format (G.729A).
Note: The Browse button is not available if VRM Pro Admin is running on 

a different server than VRM Service.

Encryption
The pooling page is also where you can specify your encryption format 
preference. 
1. To store voice recordings in encrypted format, select the option WAV 

Encrypted PCM (8khz, 8bit, Mono, 8.0kb/sec). This will encrypt voice 
recordings with AES 256.S.

2. Click OK.

Changing the Encryption Password
You can change the encryption password as needed. Note, however, that 
doing so will re-encrypt all recordings, which may take several hours and 
may tie up a significant number of system resources. 
To change this password, click Change Encryption Password. Enter the 
old password and a new password (twice). 
Note: In order to change the default password, you must leave the “Old 
Password” field empty.
20 VRManager Pro Manual 



Storage Page
On the Storage page you can set backup conditions for the storage of voice 
records.

Select from the following conditions:

• Automatic delete record without backup – VRM Pro Admin will 
delete records without backing them up. To set additional automatic 
delete parameters, select any of the following options:
 Delete records older than x day(s)
 Delete records when free space below x MB
 Delete records when free space below x %

• Schedule Backup – VRM Pro Admin will automatically back up, then 
delete records. To specify backup parameters, select from the following 
options:
 Back up records older than xx days
 Start when free space below x MB
 Start when free space below x %
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• Schedule – For detailed settings, click Details. Use the drop-down list 
to select the Schedule Task (Daily/Weekly/Monthly), use the up/down 
arrows to select the Start Time and to define the Daily Schedule 
(every x days), Weekly Schedule (any day in every x weeks), or 
Monthly Schedule (any date in every month), then click Apply.

Use the Advanced button to set a Start Date and End Date; or 
check the Repeat Task checkbox to set up parameters for a 
continuous schedule, then click OK.

Check the Show multiple schedules checkbox to display and set 
up more than one schedule. You can add new multiple schedules, 
then modify them.

• Backup Storage – Enter the location for the backup storage, or use 
Update to select a new location.
22 VRManager Pro Manual 



 

You can enter a local path or network path. The destination of the 
backup location must be valid and accessible in the local computer or 
remote computer. The user must have full privilege to read/write to the 
shared and local folders. Also, VRManager supports backup to 
DVD/RW; simply enter the path for the DVD/RW location.
Note:The Browse button is not available if VRM Admin is running on 

a different server than VRM Service.

• Execute Now button – Click this button will begin backup of records.
When you have finished setting backup parameters, click Apply or OK.

Log Page
A log file for the VRM Pro server is created each day named 
“yyyymmdd.log” (for example, 20040404.log). A daily report for the VRM 
server is also created “yyymmdd.rpt” (for example, 20040404.rpt). The Log 
window allows an administrator to set the directory paths for VRM log and 
report.
Note: The Browse buttons are not available if VRM Pro Admin is running 

on a different server than the VRM Pro Service.
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• Set Log Directory – Use Browse or enter a path to specify where you 
want log files to be saved; check the Delete the log files older than x 
days checkbox to delete archived log files.

• Set Daily Report Directory – Use Browse or enter a path to specify 
where you want daily report files to be saved; check the Delete the log 
files older than x days checkbox to delete archived daily report files.

• Send daily report by mail – VRM will send a report When there is a 
warning or error or Always. Use the Mail Configuration button to 
configure the recipient’s email address. Click Test to send a test email.

Click Apply or OK when finished.

MAXCS ACM Page
The MAXCS ACM page displays the MAXCS servers and centralized 
recording directories that VRManager Pro will access. Here, administrators 
can add or delete MAXCS servers and specify the centralized recording 
folder for the specified server.
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Adding Servers
To add a new MAXCS ACM server, refer to the next sections.

Add servers at the MAXCS system
1. Make sure the Centralized Storage directory is located on the local 

drive on the MAXCS system.
2. Share the storage directory with Full Control to a domain user or local 

administrator.

Add servers at the VRM Pro Server
1. On the MAXCS ACM page of VRM Pro Admin, click New.

2. Enter the MAXCS ACM Server IP Address, Centralized Recording 
Directory (the Share name of the centralized recording folder), User 
email address and Password. Then click OK. 
Note that if the user account belongs to an NT domain, you must enter 
“NTDOMAIN;username” in the User Name edit box. 
If the account is local Administrator, just enter administrator. 

After adding a new server, VRM Pro Service immediately checks the 
MAXCS server for the VRManager Pro License.
The newly added server is displayed in the MAXCS ACM Server list.
Note: VRManager Pro starts converting all voice recording data as soon 

as the MAXCS ACM Server information is added to the MAXCS 
Server List.

Changing the Centralized Recording Directory
To edit a MAXCS ACM server’s location for the centralized recording 
directory, highlight the server in the server list, then input the new location 
in the Centralized Recording Directory field.
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Database Page
On this page, you can specify database connection details.

The database information on this page specifies the database to store VRM 
Pro application data. 
For the Database Server Address field, you can indicate a specific port by 
appending the port number after the IP address, preceded by a colon 
character. For example: 127.0.0.26:1500.
Click Test Connection to confirm that the configuration is correct.

Integration Page
This tab is where you enable or disable integration with the Quality 
Management application. This application is described in a separate 
document, Quality Management Guide. Refer to that document for 
installation instructions. 
To enable or disable integration with the Quality Management application,
1. Click the Integration tab.
2. Check or clear the option Enable Quality Management Integration. 
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3. If needed, update the URL for the server where Quality Management 
feature has been deployed.

You can also click the Activity button to review activity on voice recordings.
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C H A P T E R  3

Using VRManager Pro Client
The actions that you can perform within VRManager Pro Client will depend 
upon the privileges that your administrator has granted to your user account. 
This section describes all of the possible actions; if you try to perform an 
action for which you do not have sufficient privileges, an alert will let you 
know.
To run VRManager Pro Client:
1. From the Windows Start menu, choose VRManager Pro Client.

2. Enter the VRM Pro Server IP address or server name, User name and 
Password. 

3. Check the Save Password checkbox to have the VRM Pro Client 
remember the password the next time the program is run. 

4. Click OK.
Note: Each Windows user has a unique VRM Pro Client login setting.

VRM Pro Client Main Window
When you start VRM Pro Client, the first window you see is the main 
window.
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At the top is a menu bar, and below is a quick-access toolbar. At the bottom 
is a scroll bar for viewing the columns.
Note: Each Windows user has a unique VRM Pro Client display column 

in the main window.

Menu Bar
Using the menus, you can perform the following functions:

• File – Export Voice Record, Export Search Result, Change Password, 
Exit

• Edit – Search, Play, Play this Session, Display column, Option

• Report – Report

• Help – Help Contents, About (VRM Client version information)

Quick Access Toolbar
The toolbar contains buttons that are menu shortcuts.
Exports the recording or search 
results to a specified location

Opens Report 
Generation dialog box

Opens client 
version 
information

Opens search 
options

Plays the 
selected voice 
recording
30 VRManager Pro Manual



File Menu
On the File menu, you can export records, export search resuts, and change 
your password.

Saving Files
You can export search results and save actual recording files, depending 
upon the privileges of your user account. The next figure shows the menu 
that opens when you right-click in your search results.

Exporting Search Results
To export the search results to a .csv file, choose File > Export Search 
Result from the main menu, or right-click the search results list and choose 
Export Search Result.
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Exporting Voice Records
To export voice recordings, 
1. Select the record or records to export. Use Ctrl-Click to select multiple 

records.
2. Right-click within your selection and choose Export Voice Record.
3. Choose a folder and click Save.

Change Password
In VRManager Pro, user passwords must meet a more complex standard 
than in VRManager:

• Passwords must be at least 7 characters long

• Passwords must contain:
 at least one upper-case letter
 at least one lower-case letter
 at least one numeral
 at least one special character: # ! ? ^, or @

• Passwords cannot contain your user ID

• Passwords must be different from previous passwords
To change your password: 
1. Choose File > Change Password from the main menu. 
2. Enter the necessary information in the Old Password, New Password 

and Confirm Password fields, then click OK. The new password will be 
required the next time that you log in.
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Edit Menu
Searching Voice Records
To search voice records, choose Edit > Search or click Search in the 
toolbar. 
You can search based on various conditions.

The relational symbols for each condition include:
= (equal)
< (greater than)
> (less than)
>= (less than or equal to)
<= (greater than or equal to)
<> (not equal)
like (look for sub-string)
btwn (between)
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in — searches the results in sets; for example, CallerID “In” “101 AND 
102” means CallerID equals 101 or CallerID equals 102.

Notes
• The date/time format is the same as the system format of the operating 

system.

• Typing “OR” in upper case in the edit box means “or.”

• Typing “AND” in upper case in the edit box means “and.”

• To leave out a condition, leave the edit box empty. 

• Only the Comment column will be editable directly from the main view 
window.

Starting with Release 8.6.1, you can search by Call Disposition code if your 
organization is using those codes.

Searching for All of an Extension’s Voice Records
If you query a specified extension’s voice records and in that query you also 
specify a workgroup, the query results show only the extension’s voice 
records related to the workgroup. The results do not show non-workgroup 
voice records. 
If you want the query results to display all voice records for that extension, 
leave the WorkGroup field blank.

Working with Voice Records
Depending upon how your administrator set up your VRManager account, 
you may have privileges to perform certain actions on recordings. Actions 
can include:

• Play — Play voice recordings (see Playing Voice Records on page 35)

• Trim — Trim the voice recording, in order to remove any confidential 
information before exporting it to a file (seeTrimming Voice Records on 
page 36)

• Export — Export the voice recording to a file (see Exporting Voice 
Records on page 32)

If you organization has implemented the Quality Management application, 
you can evaluate voice recordings. Your VRM Pro Client user account must 
have the appropriate permissions in order for you to access that application 
and perform assessments. See Performing Assessments on Voice 
Recordings on page 36.
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Playing Voice Records
Calls may be broken into separate recording segments. All recordings from 
a single call share the same Session ID. Therefore, a complete call may 
include many records, all with the same Session ID.
To play a single recording segment, use the Play command. 
To play a complete call, including all segments, use the Play this session 
command.
To play a voice recording,
1. Right-click a voice record in the main window and then click Play. A 

new panel opens.

Note that deleted voice files do not play.
2. In the Voice Recording Player, click Play. The playback begins from the 

current position.

You can click Play Next to play the next session without having to choose 
it from the list.
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Trimming Voice Records
For privacy reasons, some recordings may need to be trimmed before 
exporting. You can trim and export voice recordings (if you have been 
granted the appropriate privileges). Note that the original recording will not 
be affected by any trimming.
1. To begin playing this recording, click Play. (Note that you can pause 

and stop the playback as needed, by clicking those buttons.)
2. When you reach the beginning of a section that contains sensitive 

information that must be removed before you export the file, click Set 
Left. This marks the beginning of the section to be deleted from the 
exported version. You will see a vertical notation to mark this spot. 

3. When you reach the end of the confidential information, click Set Right. 
This marks the end of the section that should be removed, and it is 
designated visually by another vertical mark.

4. After the recording has played, or after you press Stop to stop the 
playback, you can adjust these left and right markers as needed. To do 
so, click the circle along the timeline on the top and drag it earlier or 
later, as needed.

5. To remove the section between the begin (Set Left) and end (Set Right) 
markers, click Trim.

6. Repeat steps 6 and 7 as needed to remove any other additional 
confidential information from the recording.

7. Click Export to save the trimmed file. Specify a name and a location for 
the file.

Performing Assessments on Voice Recordings
If your organization has set up AltiGen’s Quality Management application, 
which helps organizations improve the overall quality of service by 
performing evaluations of calls, you can click the Assessment button in the 
Voice Recording Player to jump directly to that application. 
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Note: Your administrator must have assigned specific privileges to your 
VRManager account in order for you to work with recordings and 
forms in the Quality Management application.

Displaying Columns
You can select which columns you want displayed in the main view window. 
These are the column headers you can select from:

• ID

• Callee ID

• Session ID

• Caller ID

• DNIS

• Workgroup

• Length

• Date

• State – There are three states that a record file can be in:
 Delete: In this state, a record cannot be played or exported.
 Backup: In this state, you must manually put the right backup media 

in the path if you back up the record and remove it.
 Normal: In this state, the file can be played or saved.

• Comment
To select columns for display, 
1. Choose Edit > Display Column. The fields in the Visible list appear as 

columns under the VRM toolbar.
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2. Use the arrow keys (< or >) to move a field from one list to the other. 
You can use the << or >> buttons to move the entire group of fields from 
one list to the other. 

3. Click OK.

Sorting
In the main view window, you can click on a specific column heading to sort 
records in ascending or descending order on that field. You can use the 
scroll bar at the bottom of the window to view all the displayed columns.

Media Player Option
The VRM Pro client plays the selected file using a selected media player
If the media player is not defined, VRManager Pro will not play the file, and 
instead opens a dialog box so you can assign a media player. 
To select a media player,
1. Choose Edit > Option. 
2. In the dialog box, select the Media Player Location by typing the path 

in the field or using the browse button (...), then click OK.

Report Menu
You can generate reports based on agent, workgroup, DNIS or date. To 
generate a report,
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1. Choose Report from the main menu or click the Report button.

2. Click the Down arrow to select From and To dates from a calendar.
3. Select one of the following format options and click OK.
 Group by Agent Extension – Select Callee ID or Caller ID, or both, 

and enter the agent’s extension in the field.
 Group by Workgroup – Enter the workgroup number in the 

Workgroup field.
 Group by DNIS – Enter the DNIS number in the DNIS field.
 Group by Disposition Code – Enter the Call Disposition Code in 

the Disposition Code field.
 Group by Day (Daily Summary) – Formats the report based on date 

period summary for each day.
4. A window show the selected parameters. From there, select Print 

Setup, Preview, Print, or Export (as a tab-separated text file).
VRManager Pro Manual  39



40 VRManager Pro Manual



Index
Index

A
adding

client users 12
servers 25

admin password, changing 18
assessing voice recordings 15
automatic delete record without 

backup 21

B
backup 23

location 23
schedule 21
storage 22

C
centralized recording directory, 

changing 25
changing

admin password 18
centralized recording 

directory 25
client password 32

client users, adding 12
column display 36

D
database connection settings 26
deleting records 21
displaying columns 36

E
encrypting voice recordings 20
Execute Now button 23
exporting voice records 31

F
firewall, running VRM behind 7, 8

I
installing VRManager 1

L
license, VRManager 3
log file, configuring 23
login, VRM Client 29

M
media player, assigning 38

N
NAT and VRManager 7, 8

P
passwords

changing admin 18
changing client 32
expiration policy 18
password policies 18
user password requirements 12

playing voice records 34
privileges

set user permissions for voice 
records 14

Q
Quality Management application 15, 

26, 36

R
recording directory 25
records  See voice records
reports, generating 38
requirements, VRManager 1

S
saving (exporting) files 31
schedule backup 21
search symbols 33
searching voice records 33
 VRManager Pro Manual  41



Index
servers, adding 25
sorting records 38
storage

backup 22
directory, setting 19

T
toolbar 30
trimming voice records 36

U
upgrading

from VRManager 8.0 7
user privileges on voice records 14

V
voice records

assessing 15, 36
encryption 20
exporting 31
playing 34
search for actions on 15, 16
searching 33
set user permissions for 14
sorting 38
trimming 36

VRM Admin
database page 26
integration page 26
log page 23
MaxCS ACM page 24
pooling page 19
storage page 21
user page 12

VRM Client
edit menu 33
file menu 31
generating reports 38
login 29

VRManager
installing 1
license 3
 VRManager Pro Manual  42


	Installing VRManager Pro
	For Customers Who Previously Used VR Manager
	VRM Pro Server Requirements
	VRM Pro Client Requirements
	Pre-Setup Steps
	Installing VRM Pro
	Installing VRM Pro Client
	Setting Access Privileges
	Configuring Database Connection

	Using VRManager Pro Admin
	VRM Pro Admin Window
	User Page
	User Password Requirements
	Adding Users
	Editing User Details
	Configuring User Recording-file Privileges
	Configuring User Quality Management Privileges
	Reviewing Activities Performed on Recorded Files
	Changing the Admin Password
	Configuring Password Policy

	Pooling Page
	Storage Directory
	Encryption
	Changing the Encryption Password

	Storage Page
	Log Page
	MAXCS ACM Page
	Adding Servers
	Add servers at the MAXCS system
	Add servers at the VRM Pro Server

	Changing the Centralized Recording Directory

	Database Page
	Integration Page

	Using VRManager Pro Client
	VRM Pro Client Main Window
	Menu Bar
	Quick Access Toolbar
	File Menu
	Saving Files
	Exporting Search Results
	Exporting Voice Records
	Change Password

	Edit Menu
	Searching Voice Records
	Searching for All of an Extension’s Voice Records

	Working with Voice Records
	Playing Voice Records
	Trimming Voice Records

	Performing Assessments on Voice Recordings
	Displaying Columns
	Sorting

	Media Player Option

	Report Menu

	Index



